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1. Installation and Activation 

1.1 Installation 

 

This software comes with a standard Windows installation disk. You can either get a 

physical CD disk, or download the software from following web: 

 

http://musicwriterxu.com/ 
 

Step 1. After download the program from Web, you probably got a zipped file.  You need 

first use WinZip or other compatible utilities to unzip the file and put all files into a 

temporary folder.  You should be able to download WinZip on the web for free. 

After all files are unzipped and saved into a temporary folder, open that folder and you 

should find a executable file called “MusicWriterXX.exe”, here XX represents the version 

number. Run that program by double click on it. 

 

Step 2. You should see a screen like: 

 

 
 

http://musicwriterxu.com/
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Click on “Next” all the way through the installation until it finishes.  You can accept all 

default settings until you have a reason to change them. 

1.2 Activation License 

 

This software is protected by license.  If this is the first time you install the software, you 

will get a 90 day free trial.  The trail version has all the functionality except it cannot print 

the music.   You need to get a permanent license after 90 days otherwise the software will 

stop to run. 

 

If you do not have a legal license, when you start MusicWriter, a Software License 

window will pop up first (see below).  You need to send (email) the computer id which is 

shown on the screen to author.  The author will then email back the license number.  You 

type in the license number in the same window below the computer id to finish the license 

installation. This software is free for all music lovers. 

 

 

The computer id is a 10 digit number (last two digit is your current version number) and 

the license is 8 digits numbers. The licenses are unique to each computer and cannot be 

transfer to other computers.  If you reinstall the operating system, or change to a new 

computer, you need to apply for a new license. However, you do not need a new license if 

you just install an update. 

 

The Software License window can be displayed in either English or Chinese .  Click on 

button “中文” or “English” to switch . 

 

 
 

 

Send this id 

to the Author 

Type in the 

license number 

here 
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1.3 Install Music Fonts 

 

In order for the program run perfectly, we need some music fonts.  These fonts will be 

installed automatically during installation process.  However, if there some reason the 

fonts are not installed correctly, program will still run correctly though some advanced 

symbols may not be shown or shown incorrectly.  In such case, the following window will 

pop up when program starts: 

 

 



MusicWriter™ User’s Guide 

All Rights Reserved - 7 - Xiaoshu Xu 

2. Introduction  

2.1 Music Notation System 

 

The numbered music notation system, also called cipher system, was believed to be 

introduced by Jean-Jacques Rousseau in 1742 but is widely used in China and other Asian 

countries today.  It has a Chinese name called “Jianpu”, which means simplified notation.  

Throughout this software and documentation we will call it “Simplified Notation”, or 

“Simplified”.  In contrast, we will call the modern music notation system “Western 

Notation” or “Western” 

 

For more information about numbered music notation system, please visit the Wikipedia 

entry about it 

 

http://en.wikipedia.org/wiki/Numbered_musical_notation#Musical_note 

 

Or if you prefer the Chinese version, go to 

 

http://zh.wikipedia.org/wiki/%E7%B0%A1%E8%AD%9C 

 

This software is designed to create music in both the numbered notation system as well as 

in the modern music system.  Even though it is specially designed targeting to the 

numbered notation system, it has all needed functions to create Western notation music 

piece, see Chapter 10 for details. 

2.2 Terminology Used in Simplified Notation 

 

This documentation is not intended to explain the Simplified notation system.  But to make 

the documentation easier to read, we need to standardize the English terminologies used in 

this software.  Fortunately, most of the terminologies used in Simplified notation are the 

same as in the Western notation, such as chords, grace notes, measure, bars, repeat bars, 

etc.  These terminologies are already standardized in English and also have a standard 

Chinese translation.  However, the ones that are unique to the simplified notation often do 

not have standard English translation and we need to define them here. 

 

Music Note 

Also called Note, is the number 1, 2, 3, 4, 5, 6, 7 and 0.  Letter x and X can also be used 

as special note for percussion instruments such as drums. We also allow the “*” sign as a 

special note.  The “*” is used in some Chinese instrumental music pieces. 

 

High and Low Octave Dot 

It also called High and Low Dot. They are used to indicate an octave higher or lower.  It 

is marked directly above or below the note. A note can have more than one high or low 

dot but it cannot have both high and low dots at the same time. 

 

http://en.wikipedia.org/wiki/Numbered_musical_notation#Musical_note
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Underline 

Marked directly under the note, it is used to indicate the time length. A note can have 

more than one underline. A note without any underline is a quart note. Each additional 

underline will reduce the time length of the notes by half.  For example, 2 will be an 

eighth note.  The underline is very similar to the “note tail” in western notation system. 

 

Dash  

Also called Extend Line, it is a short line after a quarter note.  It is used to extend the time 

length (duration) of the quarter note another quarter beat.  A quarter note can have more 

than one dash. Each additional dash extends its length another one quarter beat. 

 

Appended Dot 

Also simply called Dot, is a dot after a note.  It is used to extend the note half of its 

original time length.  A note can have more than one appended dot. The second dot 

extends the note additional one fourth of its original time length, and so on.  This is very 

similar to the “dotted note” concept in western notation system. 

 

Key Signature 

We will always use the “1 = X” format to mark the key signature.  For example, 1 = G 

means key G.  Key signature should appear before the first note in the music, or where 

the key changes in middle of the music.  The key symbol should always be marked above 

the music line.  Occasionally people uses 6 = X.  In this program we do not suggest that 

form. 

 

2.3 Simplified Notation Format Guideline 

 

There is no universal format standard to writing simplified notation music.  Here are some 

guidelines we used in this software.  You do not necessarily need to follow the guidelines. 

But if you do not, some tasks may not function correctly, such as converting between 

Simplified and Western Staff, breaking individual component from the composed music, 

or play the music, etc. 

 

Bar Line  

Bar Lines are used to divide the measure.  There should be no bar line at the start of the 

music line when the music piece is for a single instrument (part-book, 分谱).  For 

example: 

 

 
 

Double Bar line 

Double bar lines should be used at the end of the music.  Sometimes double bar line can 

also be used at the end of a section for music that has multiple sections.  For example: 
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Full Scores Music 

Full scores music (总谱) consists of music for multiple instruments/vocal, and/or two 

hands of the same instrument, such as piano.  One should use brackets or braces to 

group the instruments at the beginning of each music line.  The following example uses 

bracket: 

 
 

The following example uses braces： 

 

 
Normally, the bracket is used to combine the group of similar instruments while the brace 

is used for the both hands of the same instrument.   

2.4 Overview of Program Interface 

 

The program interface is designed using standard Windows application conventions.  At 

the very top is the program title bar, which also shows the program version number. 

 

The next line down is the Menu bar.  It contains 10 menus: File, Edit, Text, Modify, View, 

Western, Tool, Image, Windows and Help.  The individual items under each menu are 

called the menu items.  Some menu items also contain sub items. 
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Next line down from the Menu bar is the Toolbar.  The Toolbar contains icons to launch 

the most frequently used actions, such as open file, save file, etc. All functions in the 

toolbar can also be found in the menu. 

 

On the left side of the window there is a Left Bar that also contains several often used 

functions, such as add underline, high and low octave dot, etc. 

 

At the very bottom there is a Status Bar.  The status bar displays information such as the 

page number, file name and other information as it is available to the use. 

 

 

 

 

 
 

 

 

 

There are six floating windows that supply many additional objects and functions for you 

to use.  They are: 

 

• Special Symbol Floating Window – this window contains many useful symbols. 

 

• Dynamic Mark Floating Window – this window contains all marks that you can add to 

the music. 

 

• Western Notation Floating Window – this window contains objects to create Western 

notation music. 

 

Title bar Menu bar 

Toolbar 
 

Left bar 

Status bar 

Working Area Selected Cell 
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• Text Symbol Floating Window - It contains commonly used text symbol, such as pp, f, 

rit, etc.  Though you can always using text to add these symbol, this window gives you 

a quick way to do so. 

 

• Play Music - This window will open allow you to play currently opened music.  Details 

see Chapter 15. 

 

• GongChi - GongChi is a traditional Chinese music notion system.  It still used today on 

some Chinese Opera and other cases.  When this Window opens, the software enters so 

called GongChi mode and will allow you choose the GongChi characters and symbols 

from it and add to the music.  Details see Chapter 17. 

 

 

The float windows can be hidden or visible.  To show or hide the floating windows, click 

on the icon  from toolbar respectively, or select the 

corresponding menu items from the Windows menu. 

 

Many menu items or icons have a shortcut key.  You can quickly execute these functions 

by simply pressing the shortcut keys.  To view the shortcut key for menu items, open the 

menu and looking for the key symbol on the right side of the menu item.  For the icons on 

the left bar and on the floating windows, you can hover the mouse point over the icon and 

a popup hint box will display the shortcut key. 

 

 

 

                                                      
 

 

In the middle of the screen is the work area.  The work area is divided into grids.  Each 

individual unit is called a “Cell”.  User can select a single cell or blocks of cells.  The 

border of the selected cells is highlighted in blue.  All user input will apply to the selected 

cells. 

 

If you click on the right mouse button when the mouse point is in the working area, a so 

called quick access menu will popup that will allow you access to some commonly used 

“m” is 

shortcut for 

adding slur。 Shortcut for adding 

a slur 
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functions. The contents in the quick access menu may be different depending on what is 

currently selected.  

 

 
 

2.5 English and Chinese Display 

 

The software can be displayed in either English or Chinese.  To switch between these two 

languages, you can simply press F7 key, or choose “Use Chinese Version” or “Use English 

Version” menu item in Help menu. 

 

Please note that if you are running English version of Windows OS, you need to setup your 

environment correctly in order to run Chinese version.  Please see document “How to 

Setup Chinese for MusicWriter.doc” for details.  If you are running Chinese version 

Windows OS or using Windows 8 and later OS, you should be able to run the software in 

Chinese without additional work. 

 

2.6 Cells 

 

A Cell is the basic unit of the music sheet.  Each cell can contain one note (including 

append dot and dash), or 1-3 symbols arranged vertically.  For example: 

 

 

 

Quick access menu 

Cell contains 

two symbols 

Cell contains 

one note 
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A cell cannot contain a note and a symbol at the same time except for certain cases which 

will be explained later.  However a dynamic mark (e.g. slur) can co-exist with note and a 

symbol in same unit.  A dynamic mark can co-exist with a note or symbol at the same cell.  

For example: 

 

 
 

 

 

 

At above example, the slur mark is co-exists with note 2 on the same cell even though the 

slur is displayed above the cell and cross two cells.  We will explain this phenomenon later 

in section 3.4. 

 

A cell can also contain a text string.  A text string can be any English or Chinese character 

string.  Though it can run much longer then the cell width, a text string actually also 

belongs to a single cell where the text starts.  We will discuss the text in more detail in 

section 3.7. 

 

The cell always has a 1 to 2 width to height ratio. The size of all objects on the music is 

automatically determined by the cell width, which includes notes, symbols, marks and 

texts.  You can change the cell width in the preference dialog, see section 8.1. 

 

A slur co-exists with 

note 2 on the same cell 
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3. Create Basics Simplified Music 
 

Note: Before creating a new music piece, please make sure your paper size and cell size is 

set properly.  Even though you can change the paper size and cell size later but that can be 

painful after data is entered.  You can set these parameters in the Preference dialog, see 

section 8.1 for details. 

3.1 Select Cells 

 

You need first to learn how to select cells because almost all operations are applied to the 

current selected cells. 

 

1. To select a single cell, simply put the mouse cursor on that cell and click the left mouse 

button. 

 

2. If you put the cursor on the bottom-right corner of selected area, the cursor will change 

to a diagonal arrow shaped like .  Now you can drag the mouse while holding the left 

button to expand the selected area. Similarly put mouse on bottom or right edge can 

expend the area on one direction. 

 

 
 

3. You also can use the arrow key on keyboard to move the selected area. 

 

4. If you put the cursor on the top-left corner of the selected area, the cursor will change to 

a cross arrow shape .  Now you can drag the mouse while holding the left button to 

move the selected area。  However using this method the contents of the selected area 

will also moves.  

 

5. Another way to select a block cells is to select the top-left cell as mentioned in method 1, 

then hold the Alt key and click the left mouse button on the bottom-right cell.  
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6. Yet another way to select a block cells involves no mouse.  Simply holding the ALT 

key and pressing one of the arrow keys the selected box will be extended along the 

direction of the arrow. 

 

7. There are two quick ways to select a row of notes that are separated by space: simply 

holding the Alt key and click on any note in that block. Or you can simply double click 

on any note in that block. 

 

 
 

8. There are two quick ways to select a single row or column: 

 

a. Holding the Shift key and click on any cell on that row. 

b. Move cursor to the left or right margin of the page, the cursor shape will change to a 

hand sign like .  Click the mouse left button to select that row.   

c. Move cursor to the top or bottom margin of the page, the cursor shape will change to 

a hand sign like .  Click the mouse left button to select that column. 

 

 

 

 

Click on this 

cell first 

Then hold Ctrl key 

and click on this cell 

A row of notes 

without space 

Move cursor to the top 

margin and click to 

select whole column. 
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9. There is a quick way to select entire page (all cells on the page) by simply pressing Ctrl 

+ A, or choosing menu item Select All in Edit menu. You can also select the whole 

page by click on the top-left corner of the margin. 

 

You can move the selection box by pressing the left, right, up or down arrow keys on the 

keyboard. 

 

3.2 Add Basic Object 

 

• To add a music note, select the cell and type a number between 0 and 7, *, or x and 

X for percussion instruments. The default note font is used here.  You can set the 

default note font (and other fonts) in Preference dialog, see 8.2.  Using the change 

font icon  on tool bar can change font and color of an individual note.    

 

• To add a dash (extend) line, select the cell and type “-“(the minus key on the 

keyboard.) 

 

• To add the appended dot, select cell and type “.” (The period key on the keyboard).  

 

• To add the underline for the note(s), select the note(s) and then type “_” (the 

underscore key on the keyboard) or “=”.  If you keep press key, additional underline 

will be added to the notes.  After the number of underlines reaches 3, it cycles back 

to 0.  To enter more than 3 underlines, use the menu item “add underline” from the 

quick access menu.  You can also use the icons from the Left Bar （ ， ，

, ）to add/remove the underline. 

 

• To add low octave dot, select the note(s) and then type “,” (the comma key). If you 

keep pressing the comma key, additional low octave dot will be added.  After the 

number of dots reaches 3, it cycles back to 0.  To enter more than 3 dots, use the 

menu item “Low Dot” from the quick access menu.  You can also use the icons

（ ， ， , ） from the Left Bar to change the low octave dot. 

Move cursor to the left 

margin and click to 

select whole row 

 

Hold Shift key and 

click on any cell on the 

row. 

Click on top-left corner 

to select whole page 
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• To add high octave dot, select the note(s) and then type “’” (the apostrophe key). If 

you keep pressing the apostrophe key, additional high octave dot will be added.  

After the number of dots reaches 3, it cycles back to 0.  To enter more than 3 dots, 

use the menu item “High Dot” from the quick access menu.  You can also use the 

icons（ ， , ） from the Left Bar to change the high octave dot. 

 

•   To add the bar line, select the cell(s) and press the “|” key.  You can also use the 

icons on the Left Bar to enter the single bar, double bar (like ), or repeat bar (like 

). 

You can have a repeat bar that has three dots for repeating three times like .  First 

add a normal repeat bar, then select the bar and press the ‘ key (the apostrophe key 

on the keyboard).  This will change the repeat bar to three dots.  Type the ‘ key again 

will change the repeat bar to one dot, then cycles back to 2 dots.  You can also use 

the quick access menu.  Selecting a repeat bar, then right-click on mouse to bring up 

the quick access menu.  Select Increase, Decrease, or Reset from the menu to change 

the number of dots on the repeat bar. 

 

Note: Bar and repeat bar must add at main layer.  See Chapter 14 for definition 

of main and back layer. 

 

• To clear all contents of a cell, select the cell or block of cells then press the DEL key.

  

3.3 Add Special Symbols 

 

All special symbols are located in the symbol floating window.  To make the floating 

window appear or disappear, select the  icon from the Toolbar or select Special Symbol 

menu item from Windows menu.  This is what the floating window looks like: 

 

 

These buttons 

are used to 

specify the 

symbol is added 

to the top, 

bottom or 

middle of the 

unit. 

Buttons to remove up or 

down symbols 

individually 
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On the top of the float window contains 5 editing buttons. The first three buttons allow you 

to specify the symbol will be added to top, bottom or middle of the unit.  The forth button 

is to delete a symbol specified by the first three button. The last two buttons is used to 

customize the symbol locations, which we will discuss them later. 

 

The main portion of the float window contains multiple pages; each page contains many 

symbol buttons.  Click on the symbol button on the Symbol window will add the 

corresponding symbol to the bottom of the selected cell.  To add a symbol at the top of the 

cell, hold the Alt key while clicking on the symbol button, hold the Ctrl key will add the 

symbol at the middle of the unit. 

 

To remove the symbol, press the DEL key, both top and bottom symbols will be removed.  

To remove only the top symbol, press Alt + DEL.  You can also click on the buttons on the 

top of the window to remove top or bottom symbol individually. 

 

The alternation symbols, such as flat, sharp and nature symbol, are shown in red, they can 

co-exist with notes.  Selecting a note cell and clicking on one of the alternation icons will 

add the corresponding sign to the front of the note.  If the selected note already has the 

alternation associated, this will remove the sign.  This is a better way to associate the note 

with a alternation rather then add the alternation in the cell before the note. 

 

 
 

 

Using the icon , , or  in the left tool bar can do the same thing.  You can also use 

the same way to add flat, sharp and nature symbol to individual notes inside a vertical 

(chords), shrink, or grace notes.  We will discuss them in details in Chapter 6.  For 

example: 

 

 
When a vertical note has multiple alternations, their position may interfere each other.  In 

such case you could press icon  

 To adjust their position. 

 

 
 

Sharp symbol 

associated with the note 
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The alternation symbols shown in red also can be used on tile or similar symbol.  For 

example: 

 

                             
 

 

 

 

To add it below the tile symbol, you just hold the Shift key: 

 

                          
 

 

 

 

 

Following are all symbols can be applied in such way: 

 

 
Note: that this will only works when only a single cell is select and the applied symbol is 

on the bottom position. 

 

Hint: Any symbol in the float window that is colored in red can be added to an 

existing note, include the Dynamic Marks discussed next.  Their position related to the 

note will be adjust accordantly. 

 

3.4 Add Dynamic Marks 

 

Marks, also called Dynamic Marks, are located in the Dynamic Mark floating window.  To 

make the floating window appear, select the  icon from the Toolbar or select Dynamic 

Mark menu item from Windows menu.  Similar to the Special symbol window, it also has 

a top strip that contains several editing buttons.  This is what the floating window looks 

like: 

 

Click on icon 

 

Click on icon  

while hold Shift key 
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Most of time a dynamic mark will be displayed across several cells, though it actually only 

occupies one cell.  To add a mark, first select a block of cells, and then click on the 

corresponding mark icon from the floating menu.  The top-left corner cell of the selected 

block is the owner cell of the mark.  For example: 

 

 

 

 

              
 

 

 

 

 

 

                                                     
 

 

 

 

 

Owner cell 

Owner cell 

 

Owner cell 
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Though the marks can co-exist with notes in the same cell, some marks will change its 

default position when co-existing with a note.  These marks have their icons shown in red.  

For example, when the slur mark co-exists with a note, it will show on the top of the note 

instead of at the bottom of the cell such as its default: 

 

                           
 

Note: There are two types of slur,  is a ellipcal1 slur while  is a arc slur.  Following 

sample show the difference.  Which to use is your choice. 

 

 
 

Edit Dynamic Mark Shape 

 

There are many editing buttons on the bottom row of the float menu.  

 

 

 

 

 

 

 

Change Mark 

Vertical 

Length 

Move Mark up 

down 

 

Move Mark 

end tail up 

down 

Delete 

Mark 

Customize 

button 

position 

Flip Mark 

Vertically 

Change Mark 

Vertical Size 
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 : clear mark only.  You can always press <DEL> key to clear the mark, but that will 

clear all objects that co-exist in the same cell as well. 

 

: flip the mark vertically.  For example:  

 

     
     

 

                   
 

      : increase/decrease the vertical size of the mark: 

 

 
 

: increase/decrease the horizontal length of the mark： 

 

 
 

: move the mark up and down ： 

 

 
 

Though you can also use  to move the mark up and down (see section 5.6), but that 

will also move everything in the cell, include the note.  This button will only move the 

mark up and down. 
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: move the end tail of the mark up and down:  

 

 
It can also be used to move the tail of diagonal and some horizontal marks (such as slur).  

 

 
 

 
 

To reset the mark to its original position and shape, simply click on icon . 

3.5 Customize the Symbol and Mark Floating Window 

 

There are tens or even hundreds buttons on the Special symbol and Dynamic Mark floating 

window.   These buttons are located on different pages.  The customization will allow you 

to have relocated some commonly used marks and symbols to the first page.  You even can 

have many different layouts saved, e.g. one for Erhu and one for Zhen.  These saved 

custom position then can be loaded later using icon , which located at the top of the 

floating window. 

 

This is how the customization works: 

1. Start customization by click on the button  from the top of the floating window. 
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2. After enter the customization, the floating window changes to: 

Use this button 

to load a pre-

saved custom 

position file 

Press this 

button to start 

customization 

Buttons to remove 

up and down 

symbols 

individually 
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3.  Move the mouse cursor to the icon that you like to move its position.  Then press the 

mouse left button and drag the icon to the new position, then release the button.  The 

icon will then be moved to the new position. 

 

4．Use button  to save the customized position to a new file, Button  to save and 

apply this position. 

 

 

 

 

 

 

 
 

Press this 

button to exit 

customization 

 

Press this one to 

load an existing 

position file 

 

Press this button to save 

the position to a new file 

 

Press this button to save 

and apply current position 

 

Exit floating 

window 

Open saved file 

 

Save current self defined 

to a file 

Apply the changes 
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5.  When all down, press button  to exit the customization.  The float window will 

restore its original appearance. 

 

Note: You may have to redo the customization after you upgrade the software. 

 

3.6 Triplets and Multi-lets 

 

You can use the  icon on the Dynamic Mark window to create triplets and multi-lets. 

 

1. Select the block of notes that will be the triplets or multi-lets. e.g.  

 

  or   

 

2. Click on the  button in the Dynamic Mark floating window.  A triplet or multi-

lets slur will then be added: 

 

 
 

If necessary, you can also create the triplet or multi-let marks by combining the slur and 

text. 

3.7 Add Texts 

 

Like marks, the text occupies one cell no matter how long it is. Staring from version 3.9, 

we have added a new way to enter text while still keep the original method.   

 

Method 1. Click on the  icon on tool bar will let the program entering a so called ”Enter 

Text” mode meanwhile the icon will displayed as pushed down. You will first need to 

choose to enter English or Chinese text. You can then type the desired text in the selected 

cell, and then enter RETURN key to complete.  The program will stay in the “Enter Text” 

mode so you can continue to enter text by select other cells.  To exit this mode, simply 

click on the icon  again. 
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Method 2: We still keep the original way to enter text. To add text in this method, first 

select a cell that is the start location of the text, then choose “Add Text” from the Text 

menu.  The Add Text window will pop up (see below). 

 

You can enter a single line or multiple line of text at a time in either English (or other Latin 

languages) or Chinese.  If multiple lines of text are entered, each line of text will occupy 

one cell after the selected cell.  In this case, you can later move each line of text to the 

correct place.  This can be convenient when enter the music words. 

 

 
 

 

If you like to enter Chinese text, you must check the Chinese radio button and make sure 

your current input method in the OS is compatible to Chinese.  For detail on how to set up 

a Chinese input environment, see document “How to Setup Chinese for MusicWriter.doc”. 

 

Text font edit icon 

 

Type text 
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All text, English or Chinese, will be shown in the default font defined in the Preference 

dialog (see 8.2).   If you change the default font in the preference, all texts entered using 

the default font will be changed to the new font.  This is an easy way to make all texts look 

different.  For example, one can use this method to switch between simplified Chinese and 

Traditional Chinese.  Therefore, unless you have a special reason, you should stay with the 

default fonts. 

 

You can change the settings of individual text by click the icon  on tool bar. The text 

font edit menu see as below: 

 

 
 

 

You can use this window to change the font of selected text, including its color and size. 

 

Hint: You can also use this window to change the font size, color, and other style for notes, 

see example below: 
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3.8 Add Commonly Used Text Symbol 

 

Using the Text Symbol float window, shown above, allows you to add some commonly 

used text symbol to the music.  

 

 

       
 

 

 

Note: Text size only applies to dynamic symbols, such as f, p, etc. 

3.9 Other Misc. Items 

 

Key Signature: 

 

In simplified music one uses “1=X” to represents the Key. For example “1=G” means the 

piece is played with G key. The icon  on toolbar can be used to create the Key 

Signature. 

 

 

Text font size 
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You can also use the Text to create key signature. In such case one should following the 

suggested key signature format such as “1 = G”. 

 

Normally you must have one key signature at the beginning of the music, if not it assumes 

to C key.  You can also change the key in the middle of the music, in such case the new 

key signature must show just above the music line.  The following example the music 

changes its key from G to D.  

 

 
 

Note: Key Signature must be added to the Main Layer (See Chapter 13 for the 

definition of Main Layer and Back Layer.) 

 

Time Signature 

 

Click on the  icon from the toolbar to add a time signature.  There should be at least one 

time signature before the first music note. A music can have different time signature in 

different place.  It also can add all used time signature at beginning of the music piece. 

 
 

Note: Again the Time Signature must be added to the Main Layer (See Chapter 13 for the 

definition of Main Layer and Back Layer.) 

 

Tempo Sign 

 

Click on the  icon from the toolbar to add a tempo sign.  
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Note: Again the Tempo Sign must be added to the Main Layer (See Chapter 13 for the 

definition of Main Layer and Back Layer.) 

 

Time Signature (also called Meter Signature) 

 

Click on icon  on toolbar to bring up Time Signature dialog: 

 

 
 

Time signature will be add to current cell.  If current line is a staff line, you can also use 

“C” symbol for 4/4 or 2/2 symbol. 

3.10 Work with Images 

 

You can add bitmap or jpeg based images to the music. 

 

1. Select a block of cells where you would like the image to be embedded. 
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2. Click on the  icon from the toolbar, or use the menu item Insert Image from the 

Image menu.  An image selection dialog will pop up.  You can choose BMP or jpeg 

file types.  

 

 
 

3. If you check the Fit Picture to the selected box, the picture will be stretched to fit the 

selection box, otherwise it will fit the width of the selection box and adjust its height 

to keep its original perspective ratio. 

       

4. Click on Open button to add the image. 
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3.11 Create Your Own Symbols 

 

You can use the Insert Image function to create your own symbols.  To do so, simply 

create a bitmap (BMP or JPEG) file of the symbol.  Keep the image width to height ratio as 

the same as the cell, that is 1:2.  To ensure the best printing quality, the image should be at 

least 60 pixels wide.  To add the custom symbol to the music, select a single cell and then 

insert the image. 

3.12 Import Scanned Music 

You can import an entire page of scanned music as a bitmap image by clicking on the  

icon from the toolbar, or choose menu item Add Whole Page Image from Image window.  

A scanned image will be added to the entire page.  You cannot edit the scanned image, but 

you can add additional symbols, marks, and other notations. 

 

3.13 Background Image 

 

You can add a background into your music.  The background is a BMP or JPEG image that 

covers entire page and apply to every page (unless you choose to stop it), see example 

below.  Under Image menu, there are three items related to background image. 

 

⚫ Add Background Image:  Allow you to select an image file to use as the background.  

The background image will apply to all pages from current page and beyond.  

Therefore you can have different background at different page.  For example, you 

can at page 1 choose an image, and then go to page 4 and choose another image.  The 

music will have one background from page1 to 3 and different background from 

page 4 and beyond. 

 

⚫ Remove Background Image:  This function removes the background image. 

 

⚫ Stop Background Image: The background image will be stopped from current page 

and all pages after. 
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4. Viewing Options 

4.1 Navigate Through Pages 

A music piece normally has more than one page.  The icon group  on the 

toolbar can be used to navigate through the pages.  Use the dropdown box to go to specific 

page, or use the arrow icons to go back and forth.  If you are at the last page and the last 

page is not empty, clicking on the  key will append an empty page. 

 

Page up and down keys can also be used to navigate through the pages just like the arrow 

icons. 

 

You can always see the current page number and total page number on the status bar. 

4.2 Zoom 

 

There are various zoom options.  These options can be found under the View menu. 

 

• Using menu item Zoom in the View menu, you can zoom the view from 50% all the 

way to 400%. 

 

• Using Ctrl+F1, Ctrl+F3, and Ctrl+F4, you can zoom the view to 100%, 300%, and 

400%, respectively. 

 

• Full View option in the View menu will make the page fit to the entire work area. 

 

• Switch View will switch back and forth between current view and previous view. 

 

• Using slide bar on the right-bottom color to zoom in or out. 

 

 
 

• Select Slice View option will fit the page to the entire screen.  The title bar, toolbar and 

others are all hidden.  Clicking right mouse button will go one page forward while clicking 

the left mouse button will go backwards.  To quit from Slice view, simply press the <ESC> 

key.  If you have a wider screen, there will be two pages side by side shown in the same 

time (See following screen).  The slice view is a read only mode and no editing function is 

allowed.  The slice view is the perfect for reading the music or directly playing from the 

computer screen. 
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When you zoom in, the software will always make sure that the current selected area is 

visible in the view window. 

 

The zoom value is persistent.  That means that after you set a zoom value it will stay in 

that value even when you exit and re-enter the program until you change it. 

4.3 Other Misc. View Options 

 

• Show Grid – turns the grid on and off 

 

• Refresh – Repaints the entire page.  Sometimes after editing, there is an old piece of 

data that still displays on the screen. This is because only the editing area, not the 

entire screen is repainted.  These artifacts can happen when the editing object is 

shifted out of position.  Clicking on the refresh icon  will solve this problem. 

 

• Clear Highlight – After some operations, such as converting between Simplified 

Notation and Western Notation, some cells may be highlighted to indicate potential 

errors during the operation.  Select this menu item will clear up the highlights 
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5. Editing 

5.1 Move 

 

There are two ways to move the content of selected blocks to a new location.  The first 

method is to use the mouse: 

 

1. Select an area whose contents you would like to move. 

 

2. Move the mouse point close to the top or left edges of the selection box.  The mouse 

cursor will change to a cross arrow shape  to indicate you can start to drag. 

 

 

 
 

3. Holding the left mouse button and dragging the mouse will move the selection box 

accordingly. 

 

4. After the selection box has been moved to the desired location, release the mouse 

button.  The content of the selected area will be moved to the new location.  The 

original content in the new location will be erased. 

 

The second method is to use the copy, cut and paste functions.  See next section. 

5.2 Copy, Cut, Paste and Clear 

 

Like most Windows software, you can copy, cut and past the selected content. 

 

To copy or cut:  

 

1.  Select an area that you would like to copy or cut its contents. 

 

2.  For copy, click on the  icon or press Ctrl + C.  For cut, click on the  icon or 

press Ctrl + X.  The selected content then will be copied or cut to the clipboard. 

 

To paste from clipboard, select a cell that will be the top-left corner for the to-be-pasted 

contents, then click on the  icon from the toolbar, or press Ctrl + V. 

 

Move mouse 

cursor to this 

area 
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After you have placed content into the clipboard, you can open a new music piece and 

paste the content to the new music piece. 

 

You can also only paste the dynamical mark, font or offset of the copied cell to the target 

cell without change other contains of the target cell.  These special paste functions can be 

found under “Special Paste” menu item. 

 

You can also paste the contents to another Window’s application, such as MS Word and 

Excel.  The contents pasted into other Windows applications will be high resolution bitmap 

based images.  You can even adjust the bitmap resolution using the “Copy to Clipboard” 

quality parameter, which is specified in the preference menu. 

 

If you would like to clear the contents of selected area, you can simply press the DEL key.  

The content in the selected are will be cleared but will not copied to the clipboard. 

5.3 Delete and Insert Lines 

 

You can easily delete a line or insert a line into the music. To do so, choose menu item 

Insert Line or Delete Line from the Edit menu.  You can also use the short cut keys Ctrl + 

INS and Ctrl + DEL.  

 

When a line is deleted, all contents after this line will be moved up by one line.  When a 

line is inserted, all contents after this line will be moved down one line. 

5.4 Delete and Insert Cells 

 

You can easily delete cells or insert empty cells into the music. To do so, select a cell, then 

choose menu item Insert Cell, a new empty cell will be inserted at this location.  If you 

choose Delete Cell from the Edit menu, the selected cell will be deleted.  You can also use 

the short cut keys Ctrl + I and Ctrl + D.  

 

When a cell is deleted, all contents on the same line after this cell will be moved left one 

cell.  Empty cell will be appended to the end of the line.  When an empty cell is inserted, 

all contents on the same line after this cell will be moved right one cell.  The content in the 

last cell will be lost. 

5.5 Delete and Insert Measures 

 

Delete Measure 

 

You can delete a measure.  First select the cell within the measure you would like to delete. 

Then choose the menu item Delete Measure from the Edit menu, or use the short cut key 

Shift + DEL.  The measure will be deleted from the music and all measures after it will be 

shifted up coordinately. 

 

The delete measure can also apply to the full score music (the music with multiple parts.) 
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The delete measure works best if all the measures have the same number of cells.  If you 

have a cell which has significantly more cells then the previous measure, the software may 

have trouble fitting all the objects in this measure to the previous one.  In such a case, the 

operation will stop here and the measure that has trouble continuing will be highlighted 

with a yellow background color.  You can manually resolve this conflict then continue the 

“Delete measures” operation from where it stopped.  This is an example: 

 

 

 

 

 
 

After pressing the Shift + DEL key, we have: 

 

 

 

 

 
 

 

We can now manually solve the conflicts by shrinking the notes in the long measure: 

 

This measure will be 

deleted. 

The measure has 

been deleted 

But we have 

conflicting. 
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Then continue to delete the measures afterwards by pressing Shift + DEL again. 

 

 
 

 

Insert Measure 

 

There is no direct function to insert a measure because when conflicts happen, as we 

explained above, we may lose data.  However, there is a way to insert a measure by using 

the delete measure function.  This is an example: 

 

 

 

 

 

 

 

Conflicting solved and 

this empty measure 

needs to be deleted. 
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1. First, insert few empty ines after the line where the measure needs to be inserted so 

that you have enough space to copy the line as described in the next step: 

 

 
 

2. Then make a copy of the line that you would like a measure to be inserted: 

 

 

 

Where a new measurement 

needs be inserted here 

Copied line 
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3. The third step is to clear all objects in the duplicated measures so that it will look 

like you have inserted multiple empty measures into the intended position: 

 

 
 

4. Now use the Shift + DEL key to delete unwanted empty measures until you get the 

desired result: 

 

 
 

Delete Measure Options 

As we have seen, when you delete a measure, the measures after it will be shifted up.  In 

many cases, you may like to shift not only the measures, but also the symbols and marks 

above and below the line together. You can specify this option by choosing the Delete 

Measure Setting from the Edit menu.  This is the Delete Measure Setting dialog: 

 

 

Copied line with 

duplicated 

measure cleared 
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This dialog allows you to specify how many lines above and below the measures will be 

shifted together with the measures. 

5.6 Change the Size and Position 

 

Change Size 

 

All the notes, texts, images and some of the symbols can be resized.  To do so, select the 

object and click on the  icon (decreases the size) or  (increases the size).  You can 

also select an actual scale value from the pull down menu by clicking on the arrow beside 

the icons.  Click on the  icon can reset the size back to the default.  As usual, there are 

corresponding menu items that can do the same thing that are found under the Modify 

menu. 

 

Even though you can resize the notes, if you have to resize many notes you may need to 

change the cell size instead of using the resize option.  The resize should only be used in 

special occasions. 

 

Move Position 

 

You can move any objects up, down, left or right using  icons.  Each click 

shifts the object about 1/5 of the cell width.  If you press Shift key while clicking on those 

icons, it will only move 1/15 of the cell width. The icon  will reset its position to the 

default.  You can also use the arrow key short cuts to move items, they are: CTRL + UP, 

CTRL + DOWN, CTRL + LEFT and, CTRL + RIGHT arrow keys. 

 

If an object is moved too much from its default position, it will not be easy for users to 

know where its owner cell is.  There is a menu item called “Show Owner Cell” under the 

View menu.  If this menu item is checked, a red arrow will be drawn from the shifted 

object to its owner cell for the objects that has been moved. 

 

Properties 

 

Being able to change the size and position of objects gives the user great flexibility to 

design music that looks right. The size and position of an object is called the property.  

You can numerically change the object’s property using the property dialog.  To do so, 

select the object, click on the  icon which will bring up the property dialog and you can 

then change the values.  
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1 unit offset equals to 1/5 of the cell width. 

5.7 Undo and Redo 

 

Like most other Windows programs, you can always undo any editing you have done.  The 

 icon in the toolbar allows you to undo, or you can simply press Ctrl + Z for undo.  

 

After undo, you can also to redo the undo by pressing Ctrl + Y or use the  icon in 

toolbar. 
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6. Shrunken Notes, Vertical Notes and Grace Notes 

6.1 Shrink Notes 

 

In some cases there is not enough space in a measure to fit in all the notes.  For example 

you may have a lot of 16th or 32nd notes in one measure.  In such cases you can shrink 

these notes horizontally.  To shrink a row of notes, you need do: 

 

1. Select the row of notes you would like to shrink, it should contains at least two notes. 

 

 
 

2. Click on the  button in the toolbar, or choose menu text->Shrink Notes, or simply 

press F10.  The selected block will be shrunk to about the half the size in the 

horizontal direction.  

 

 

 
 

Note: 

 

1.  The shrink should only be done occasionally since it requires extra steps to edit the 

shrunk notes (see 6.4).  If you have to shrink too many notes, you may want to either 

increase the size of each measure or you may even want to reduce the size of the cell. 

 

2.  To reduce possible editing in the future, make sure the notes have correct form 

before shrink them, including the high/low dot, appended dot, underline, sharp, flat 

and nature signs. 

 

 

3.  The shrunken notes actually occupy only one cell, which is the first cell of the block 

though it appears in more than one cell. 

 

4.  The shrunken notes can only include notes (include append dot) and space. 

5.  You can change the amount of shrinkage.  First select the shrunken notes, then click 

on the dropdown arrow beside the  button and choose Increase, Decrease, or 

Reset menu items. 
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6.  Once the notes is shrunken, it can be unshrinking if you select it and click on Shrink 

icon again.  The program will try to find enough space original space to hold these 

unshrinking notes. However, if there is not enough space, it may cause some data to 

be lost. 

6.2 Edit Shrunken Notes 

 

After a row of notes has been shrunk, it cannot be directly edited as normal notes.  You 

need to first let the system know which notes need to be edited since all notes occupy a 

single cell. 

 

1. Select the shrunken notes, you only need select the first cell, since shrunken notes 

block only occupies one cell which is the first cell (but it does not hurt anything by 

selecting more than one cell). 

 

 
 

2. Click on Ctrl + <number>.  Here the number is the key 1 to 9, indicating which note 

is about to be edited, for example Ctrl + 3 is for editing the third note. If Ctrl + 0 is 

pressed, the edit will apply to all notes in this shrunk block. A text will show up in 

the status bar at the bottom of the window to indicate which note will be edited. 

 

 

 

 
 

 

3. Then type the changes as you normally do.  The keys that are valid in this case are: 

numbers 0 to 7, comma (for low octaves dot), apostrophe (for high octaves dot), 

period (for dot note), underline (for note length) and SPACE. You can also click on 

the corresponding icons that change the underline, high dot or low dot. You can also 

add or remove the sharp, flat or nature sign of the specified note. You can replace the 

note with empty space but you cannot delete a note from the shrunken block. 

However, you can always clear the shrunk block and redo it. 

 

After Ctrl + 2 is pressed, the 

status bar shows the change 

will apply to 2nd note 

http://en.wikipedia.org/wiki/Octave
http://en.wikipedia.org/wiki/Octave
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There is also another quick way to edit the individual shrunken note: 

 

• Hold the Alt key while typing or clicking on the proper key/menu items will modify 

the first note. 

 

• Hold the Alt + Ctrl keys while typing or clicking on the proper key/menu items will 

modify the second note. 

 

• Hold the Alt + Shift keys while typing or clicking on the proper key/menu items will 

modify the third note. 

 

• Hold the Alt +Ctrl + Shift keys while typing or clicking on the proper key/menu 

items will modify the fourth note. 

 

• The “_” key will not work with this key combination since you have to hold the shift 

key to type the “_” which will cause a conflict. 

 

You can edit vertical notes (chords) and grace notes in similar way. 

6.3 Create Grace Notes 

 

You can create a pre and post grace notes similar to the shrunken notes: 

 

1. Create the notes in the normal way.  Make sure they are in the correct form; include 

their underline, high/low dot, appended dot, sharp, flat and nature signs.  For 

example: 

 

 
 

2. Select the entire block, then click on the  icon (for pre- grace) or  (for post- 

grace) from the toolbar (You can also use menu items “Pre Grace Notes” and “Post 

Grace Notes” from the Text menu.) The selected block will change to the proper 

grace notes, e.g.: 

 

 
 

Like shrunken notes, the grace notes also occupies one cell which is the first cell of its 

original notes.  You can still modify and unpack the grace notes similar to the shrunken 

notes.  See Section 6.2 “Edit shrunk notes”. 

 

The vertical notes that will explain next also can convert to grace note: 
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6.4 Create Vertical Notes 

 

Vertical notes are blocks of notes listed vertically.  For example: 

 

 
 

Most of the time, vertical notes are used to present the chord notes.  Sometimes it can also 

to be used to presents multiple part of the musical instruments.  For example, the top notes 

for Erhu 1 and bottom notes for Erhu 2. 

 

You can certainly create the vertical notes by typing them separately in adjacent cell like: 

 

 
 

But not only will this make it look too tall, but also the notes are not recognized as a group 

of notes and will not convert correctly when we try to convert the music to the western 

notation, or break the music into multiple parts, or when you play the music.  The best way 

to make a chord notes is to create a vertical note block. 

 

Similar to shrunken or grace notes, to create vertical notes, you first type the notes in a row 

that you want to be part of the vertical notes block.  Make sure they are in correct form, 

including high-low dot, appended dot, sharp, flat and nature signs.  Then select the block 

and click on the  icon, or select the menu item Vertical Notes from the Text menu, or 

simply press F9. 

 

     
 

The system will make sure that the upper note is always higher than the lower note during 

the process.  For example, if you type 531, it will convert to 5, 3 with one high dot, and 1 

with 2 high dots: 
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Another quick way to create vertical notes is to press Ctrl-Z, this will add an additional 

note on top of current note (so it become a vertical note if not already is). The added note 

is two steps higher than current note. 

 

 
 

Also Ctrl-X key can be used to delete top note from a vertical note. 

 

Like shrunken notes, the vertical notes will occupy one cell which is the bottom cell of the 

vertical note.  You can modify and unpacked the vertical notes similarly to the shrunken 

notes.  See “How to edit shrunk notes”.  The only exception is the underline.  You can not 

specify the underline for individual notes.  The underline for the vertical notes only applies 

to the entire block.  You can edit the underline like a normal note. 

 

6.5 Create Two Parts in One line  

For Jianpu, sometimes you need write two parts of the music in one line. For example: 

 

 

 
 

 

 

 

 

 

 

 

If the duration of two parts is the same, you can simply use the vertical notes to create 

them. If the duration is different you must use back layer to handle it.  See section 13 for 

how to use back layer.  We will explain how to create two parts when the time is different.  

 

6.6 Use Pre-Defined Chord 

 

There are several predefined chords to choose, which all defined in the dynamic mark 

window.  To select a predefined chord:  

Same duration of 

two parts. 

Different duration of 

two parts. 
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1. Enter the root note of 1, 2, 3, 5, or 6 with proper high or low octave dot.   

2. Select the cell and click on the  button (for 3 note chord),  (for 4 node chord), 

or  (for 7 note chord) from the Dynamic Mark window. 

 

This is a 4 note chord example: 

 

     
 

If you want to add a arpeggio symbol on the left side of the chord, choose , , or   

button instead.  The following is a 3 note chord example with arpeggio symbol: 
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7. Files and Print  

7.1 Create New Files 

 

To create an empty file, you can choose New from File menu.  If you want to create a sheet 

with predefined template, you can first create a music line with your desired measurement 

lines, then use Copy/Paste function to reproduce it in entire page. Then you can copy this 

page to the following page to create multiple empty page with the same template. 

 

You can also save an empty page with desired template to a file and use it later. 

 

Create a desired empty music line: 

 

 
 

Then copy/paste to reproduce the line to entire page. 

 

 

7.2 Save, Load and Share Music Files 

 

Using Save or Save As from File menu, the music can be saved as a MusicWriter file that 

has extension “mus”.  Though you can use other letters for the file extension, we strongly 

suggest you stay with the default extension. 

 

After the file is saved, it can be loaded back to the MusicWriter using the Load menu item 

from the File menu.   

 

The MUS file is a self-efficient file (except for large image >10MB).  That means you can 

share the MUS file with other people who has MusicWriter by sending them the MUS file.  

There are a few notations: 

 

• Depending on how the default fonts are setup on the computer, the MUS file loaded 

may look different in fonts from its original font when it was created.  This can be an 

advantage.  For example, one can create the music in Traditional Chinese.  Another 

person can open it in simplified Chinese without make any changes. 
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• If the MUS file contains large images that is more than 10MB, the actual images are 

not contained in the MUS file, and only the location of the image file is saved on the 

MUS file.  In such case, you also need to share the image files. 

7.3 Browser Music Files 

 

The Browse function in File menu allows you to browse a directory and list all music files 

by its title, file name and number of pages.  This function helps user to easily locate the 

correct music piece to open. 

 

 
 

 

Determination of Music Title 

 

The title of a music piece is determined by the following rule: The first text string within 

the first 10 lines of the music that contains at least 1 Chinese character, or 5 English 

characters.  If a title string cannot be found, the file name will be used as the title.  For this 

reason, one should always put the title text as the first text in the music. 
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7.4 Print Music Files 

 

To print current music, choose Print from File Menu.  The print dialog will open like: 

 

 
 

You have several options to choose and all are self-explanatory. 

7.5 Save Music to Image File 

 

You can also save the music as an image file.  You can save as either a JPEG or BMP file 

format.  The JPEG is preferred since it is a compressed format and will take less disk space 

than BMP.  You can use image files to share music with others who do not have the 

MusicWriter software. 

 

To create the image file, choose Export menu item from the File menu, the Save to Image 

File dialog will pop up. 
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You need specify image file width.  Larger the width is the bigger the file and better the 

resolution will be.  If the image width is too large, the computer may not have enough 

memory to create the file and in such a case an error window will pop up to ask you to 

reduce the image width. In general, the up limit of BMP file is larger than JPEG file.  

Therefore if the width of a JPEG file is too larger, you can try to change to BMP format. 

 

For BMP format, there are two types of color schemes: Black/White or Color.  The 

Black/White image will take much less space than the color image.  For JPEG file, you can 

choose Gray Scale or Color.  There is no difference in file size. 

 

If the music has more than one page, there will be multiple image files created, one for 

each page.  The image file names in such case will be the file name that the user specified 

appended with “_N”, the N is the page number. 

7.6 Save Music to MIDI File 

 

Under File menu you can find “Save As MIDI File” option, this can save your current 

music to a MIDI file. 
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8. Preference 
 

The preference dialog allows user to set up several key parameters.  To open the 

Preference dialog, choose Preference from Help menu.  All parameters in this dialog are 

persistent, that means they will not change its value even you reenter the program. 

 

 
 

8.1 Appearance 

 

Paper Size and Orientation 

 

The MusicWriter is designed to fit any size of paper.  You can either select a pre-defined 

paper size, or directly enter the paper size in inches.  You can also choose to lay the paper 

in portrait and landscape.   

 

Cell Size and Margins 

 

The standard paper shown on screen will always be 1000 pixel wide.  The user should use 

the Preference dialog to set up the Cell width accordantly. Cell height will always be twice 

the cell width.  All other sizes, such as the size for notes, texts, symbols and marks will be 

automatically adjusted based on the cell width.   

   

You can also set up margins in the Preference.  

 

Cell width and margins are all defined in pixels.  
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Note：The pixels here are not the same pixels of the screen.  It is an internal unit I 

used to define the size.  A print paper is always defined to have 1000 pixels at its short 

side no matter the size of the paper or the resolution of the rent device. 

 

 

If there is music opened and the paper size, orientation, cell width or margin is changed, 

the music will be adjusted to fit the new size.  In such case, some of the information on the 

music may be lost if the number of cells per row or per column decreases. If the number of 

cells per row or per column increases, you may need to rearrange the position of the data to 

fill the extra spaces.  Anyway, we strongly suggest that you set these parameter properly 

based on your preference before enter any data. 

 

MUS file includes the paper size, orientation, cell width and margins that are used to create 

this file.  Therefore when you open a file, it may be created using different parameters and 

these parameters will be reset from the file.  This does not mean the default values of these 

parameters have been changed.  If you create a new file, the default parameter will still be 

used. 

8.2 Font Setup 

 

 
 

Default Font Setup 

 

There are three default fonts: one for the notes, one for the English texts and one for the 

Chinese texts.   

 

If you check the “Use Chinese Version”, the software will display almost all interface texts 

in Chinese, such as the menu, dialogs, etc.  You can also uses the short cut key F7 to 

quickly switch between Chinese and English version.  See section 2.5 for details. 
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Please note that if you are running old English version of Windows OS (such as Windows 

XP or Vista), you may need to setup your environment correctly in order to run Chinese 

version.  Please see document “How to Setup Chinese for MusicWriter.doc” for details.  If 

you are running Chinese version Windows OS, you should be able to run the software in 

Chinese without additional work.   

 

On this page, you can also set up the “Copy to Clipboard” quality.  MusicWriter uses 

standard Windows Clipboard to store the copied image in a bitmap format so you can paste 

it to other Windows application.  Higher the quality is, higher the bitmap resolution will be 

used.  However, if the resolution is too high, you may not have enough memory in the 

clipboard to store the image.  

8.3 Printing and Other Misc. Settings 

 

 
 

 

In the Printing & Misc. page, you can set other options:  

 

• Print Size Adjust – Sometimes a printer is slightly different in terms of its printed 

text size, the Print Size Adjust is a percentage of the adjustment of the note font 

when printed.  If you see a font size difference between the printed copy and the 

viewing on screen and dissatisfied with the printed result, adjust this value. 

 

• Print Line Width – again, due to the difference between printers, the line thickness 

(such as the under line, dash，point, etc.) may look too thin or too thick on the 

printed copy.  Adjust this value to achieve desired line thickness. 

 

• Footnote Text Font Size – There are optional footnote on the print page that can 

show the music title, book title, and file name.   This parameter determines the size 

of the footnote text. 
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• Default File Directory – Where you commonly store your music files. 

 

• Default Image Directory – Where you commonly store your image files. 

8.4 Color Setup 

 

In the color page, you can set color scheme used in the software:  

 

 
 

• Black Note Color – In west style, on the staff software can make the note in different 

color if this note will play on black key on the keyboard. 

 

• Keyboard Key Down Color – On virtual keyboard (see Chapter 15), use this color 

for the pressed-down key. 

 

All other color settings are self-explained. 
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9. Tools 

9.1 Move Note Up or Down 

 

You can easily move the note by one step or by a whole octave.  First select the notes that 

you want to move, then use Move Note Up/Down menu item in the Tool menu.  There are 

short cut keys as well. Shift + F8 shifts them whole octave higher.  Ctrl + F8 moves them 

whole octave lower. Shift + F1 moves them one step higher. Ctrl + F1 moves them one 

step lower.  For example: 

 

 
 

After move one octave higher, it becomes: 

 

 
 

After move one step lower, it becomes: 

 

 
 

Note: move note will ignore half step.  For example, if move 1va up, 1 will be 2, but 3 will 

be 4, not #4.   

9.2 Add Measure Count 

 

The measure count can be added automatically.  Selecting Tool -> Measure Count will pop 

up the Add Measure Count dialog: 
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The first group in the dialog window allows you to specify how often the measure count 

will be added.  The second group of parameter allows you to specify where to start and the 

start number.  The Position Offset is an offset in pixels that the measure count text will be 

displayed.  Using a negative offset will allow the measure count text slightly above the bar 

line so it will look better.  Finally you specify if the measure count will be added to this 

page only or to all following pages. 

 

When measure count is added, any old measure count, if exists, will be removed. This is an 

example of a music piece that has measure count added: 

 

Automatically 

added measure 

count 
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9.3 Verify 

 

The verify function will check for any inconsistence of the beat count in each measure in 

regards to its time signature.  The inconsistent measures, if they exist, will be highlighted 

in yellow for you to examine in more details.   

 

In order for this to work correctly, you must follow the common practice of setting the 

time signature.  That is: 

 

• Always use the Time Signature icon   from toolbar to add time signature. 

• Always use the multi-let mark in Dynamic Mark floating window to mark the triplets 

and multi-lets. 

• You must have at least one time signature before the first note starts. 

• If the time signature changes in the middle of the music, you need to either mark the 

new time signature where it changes or list all applicable time signatures before the 

first note is started.  See the following examples: 

 

Add new time signature to where it changes: 

 

 
 

Or add two time signatures before the music starts: 
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9.4 Auto Underline 

 

Underlining all notes correctly can be a lot of work when you create the music.  This is a 

tool that can save you a lot of time.   

 

To execute the Auto Underline, you first select a block of cells, and then either choose 

Tool->Auto Underline, or simply press the F11 key.  If you only have one cell selected, the 

Auto Underline will apply to the entire row, otherwise it will apply to the selected area. 

 

The Auto Underline algorithm uses the following rules.  So in order for Auto Underline to 

work right, you need follow these rules as close as possible。 

 

For time signature of 4/4, 2/4, 2/2, please follow the rule below: 

 

1. If 8 or more notes are grouped together without space in between, it will add triple 

underline to them (so assume they are 32nd notes).   

 

2. If 4 or more notes are grouped together without space in between, it will add double 

underline to them (so assume they are 16th notes).  

 

3. If two notes are grouped together, it will add a single underline to them (so assume 

they are 8th notes). 

 

4. If three notes are grouped together, it will add single underline to the first note and 

double underline to the second and third notes. 

 

5. If an appended dot exists, it will add an additional underline to the following note to 

reduce its time value by half. 

 

This is a line of music before the Auto Underline applied: 

 

 
 

This is the result after Auto Underline: 

 

 
 

The rule number 4 needs a special attention because when 3 notes are together, it can mean 

 or , for example.  You may need to fix it manually.  But there is an  icon on the 

left bar that will allow you to switch between these two variations by a simply click. 

Software will highlight these notes for you to examine.   
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For time signature of 3/4, the following rule will be used: 

 

1. If 6 or more notes are grouped together without space in between, it will add double 

underline to them (so assume they are 16th notes).   

 

2. If 3 notes are grouped together without space in between, it will add single underline 

to them (so assume they are 8th notes)。 

 

For example: 

 

 
 

The result after apply the Auto Underline: 

 

 
 

For time signature of 3/8 or 6/8, the following rule will be used: 

 

1. If 6 or more notes are grouped together without space in between, it will add triple 

underline to them (so assume they are 32th notes).   

 

2. If 3 notes are grouped together without space in between, it will add double 

underline to them (so assume they are 16th notes)。 

 

The Auto Underline can do most of the job for you if you follow the rules.  However, you 

still need to verify the result after Auto Underline to make sure it is correct. 

9.5 Break Full Score Music to Parts 

 

To break full score music into individual parts (分谱), select Break Down menu item from 

the Tool menu.  A dialog will pop up as shown below. 
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First you need to specify which rule to use to identify the music line of the part you would 

like to extract.  There are 4 different types of rules: 

 

1.  By Line Count – Use the line count number to specify the music part.  In the 

following example, 笛子 will have line count of 1.  二胡 will have the line count of 

5. 

 

 
 

2.  By Instrument Name – If you have the instrument name at the beginning of every 

line, you can also use the instrument name to identify the music part.  In the above 

example, you can use text 二胡 to identify the music part for 二胡. 
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3.  By Bracket Count – Since full score music will have the bracket or brace at the 

beginning of the line to group the music parts, you can also use the bracket (or brace) 

count to identify the music part.  For the above example, the bracket count 1 

represents the music line for 笛子.  Bracket count 5 represents the music line for 打

击. The bracket count 3 will represents music line for 二胡 and 中胡. 

 

4.  By Highlighted Lines – You can manually highlight individual lines and ask the 

software to extract these lines of music for you.  To highlight a line, you need click 

on the margin area of the line (like you select the whole line) while hold the Alt Key.  

If the line is already highlighted, it will clear the highlight.  The following example 

highlights the 笛子 and 打击 parts: 

 

 
 

After selecting the rule to use, you then need to enter the parts to be extracted in the edit 

box.  If you like to extract multiple parts, you need to enter the indicators in comma 

delimitated format.  For example, if you choose the Line Count rule, and like to extract 

music for 二胡 and 中胡, you need enter “5, 6” in the edit box. 

 

Finally, you need select which additional lines to be included.  Remember the top line may 

contain the useful information such as the section name, measure count, etc. that you may 

want to keep. 

 

The following example is the result of Break Down for 二胡 and 杨琴.  We have included 

1 top line, 1 line above and 1 line below: 
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As you have seen, though the Break Down has done much of the work for you, you may 

still need to do some clean up to make the part music perfect. 

9.6 Add Bow Direction 

 

The software can add bow direction symbol automatically for string instruments.  To add 

bow direction, you need to follow the following steps: 

 

1. Make sure all the slur marks are correct for your music. 

 

2. Select a cell where you want to start.  The selected cell must be on a music line. 

 

3. Select Bow Direction menu item from the Tool menu.  The add Bow Direction 

dialog will pop up: 
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After specifying all options, click on the “Add” button.  All existing bow movement 

symbols will be cleared and the new bow movement symbols will be added.   

 

All options on the dialog are self-explanatory except the dropdown box “Find Music Line 

By”.  This option specifies the rule that is used to find music line when dealing with full 

score music.  See section 9.5 “Break Full Score Music to Part” for details. 

 

If you click on the Clear button, it will only clear the existing bow movement symbols 

without adding new ones from where it starts.  

 

Clicking on the “Reverse” button will reverse all existing bow movement symbols from 

where it starts. 

 

 

9.7 Change Tone 

 

Change tone function will change the tone of the music but keep the same pitch.  This is 

very useful especially when the music is written with fixed tone and you want to make it as 

a nature tone.  Following is an example of a piece music writing in fixed tone: 
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This piece is written in fixed C tone, however it actually is B flat in natural.  We can use 

this function to convert them to B flat tone.  When click on this menu item, a popup 

window shown below: 

 

 

 

 
 

You will need to chose correct tone to be changed.  In this case, we choose to move down 

one step, from C to B flat.  Click on OK to process: 
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You can see the piece is convert to B flat and is much more easy to read. 

 

Note: this function currently is only applicable to Jianpu. 
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10. Create Western Notation Music 
 

Though the MusicWriter program is designed for Simplified Notation, it contains all the 

abilities to create the Western notation music.  Regarding how to use western notation, 

please refer to other books.  However, here we need to define some terminology used in 

this document: 

 

Staff: A complete line of music in western notation. 

 

Clef: Clef locate at the beginning of the staff.  Clef defines the pitch of the staff.  

Comment used clefs are: G clef, F clef and C clef.  If a staff has a G clef, we call it G 

staff, and so on. 

 

Key Signature: Also called simply the “Key”. It determines which note(s) need to raise 

or lower half steps. It applies to entire staff. 

 

Alteration: temporally raise or lower the note half steps (#, b, etc.).  It only applies to its 

measure. 

    

 

 

 

 
 

 

 

 

 You can use the functions described in this chapter to edit the music that is converted from 

Simplified Notation, or create a music piece completely from scratch in the western 

notation. 

 

Most staff related functions are located in “Western” menu and “” floating window. 

 

Here is the “Western” menu: 

 

Clef 

 

Key 

 
alterations(flat sign) 
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Here is the “Western Notation” floating window: 

 

 

10.1 Create Staff 

 

1. Select a block of cells, usually a single row of cells. It needs at least three units long. 

 

 
 

Note: Though it is perfectly fine to mix the simplified and western notation on 

the same piece, it is not a good idea to mix western and simplified notation on 

the same roll.   

 

2. Choose “Create Staff” menu item from “Western” menu, a dialog will pop up asking 

you to select a clef and key.  You can select G, F, C3 or C4 staff.  The “Other Staffs” 
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page includes such as the percussion staff for percussion instruments and other 

supplementary staffs. 

  

 

 
 

 

 

3.  After selecting a desired clef, click on Ok, the specified staff will be created. 

 

This is an example of D Major G staff: 

 

 
 

This is an example of percussion staff: 

 

 
 

Note: Staff must be added to the Main Layer (See Chapter 14 for the definition of Main 

Layer and Back Layer.) 
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After you create a desired staff, use the copy/paste function to propagate the staff to entire 

page, and then use copy/paste again to create multiple pages with empty staffs. 

 

10.2 Create Grand Staff and Full Score Staff 

 

To create a grand staff, you can first create a G staff, then select “Convert G to GF Staff” 

menu item from the Western menu. Or you can manual create two staffs, one G, one F and 

connect then with the brace.  It is better to use the first method, because it is not only 

simpler but also easier to be edited later.  This is an example: 

 

 

 
 

 

The above method will create a G/F grand staff.  If you want to create a grand staff with 

same clefs, you can select one staff and choose “Create Staff” in Western menu to change 

one or another: 

 

 
 

 

 

 
 

Of course you can always manually create two staffs, select them and click on “Combine 

to Grand Staff” menu item to create a grand staff:     

 

Western menu->Create Staff 
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“Decouple Grand Staff” menu item will break a ground staff into two independent staffs. 

 

You can add measure bars and repeat bars just like you do in simplified notation: select the 

cells and click on the  icon on left bar or press the “|” key. 

 

“ 

If a clef or key changes in the middle of a row, you can easily do it by select a single cell 

where the staff changes, then similar to create a new staff, you choose “Create Staff” menu 

item under the “Western” menu, select desired new staff.  See the following example: 

 

 
 

 
 

 

Note: You must only select a single unit in this case. 

 

If only clef or key is changed, you can use “Hide Clef” or “Hide Key Signature” (will 

explain in following section) function to simplify them: 
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In some practice, one like to first reset previous key before change to new key, in this case 

the “Reset Key Signature” under Western menu can be used to add the correct nature signs 

on the cell, see below: 

 

 
 

“Reset Key” will reset to all sharp or flat alterations to nature.  Sometimes you may only 

need to reset or add some of the alterations.  We can use independent alterations (sharp, 

flat or nature sign)  to do so. 

 

In a staff, if a sharp, flat or nature sign is added to a unit that has no music notes, we call 

it a independent alteration. 

 

 

 

 

 
 

                                             

D Key                                                  G Key 

 

 

 

 

 
 

                                              D Key                                                       E Key 

 

 

 

 

Once a staff is created, you can easily convert it between G, F or C staff. You just need to 

select the staff and choose “Change Staff”.  All notes in the staff will also moved to its 

new position.   Following is an example to convert a G staff to C3 staff. 

Independent 

nature sign 

Two Independent 

sharp signs. 
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10.3 Edit Staff 

 

Once setup a staff, you can edit it in many ways. 

 

1.  Change Staff in the Western menu.   

Once a staff is created, it can change among other staffs. First you need select the 

cell that the staff located (note only select single cell).  If you only need change the 

clef or key, you can use “Create Staff” window under “Western” menu to so. See the 

following  example, the music piece changed from G staf C key to F staff D Key and 

all notes kept in its original position. 

 

 
 

 

 

 
 

 

If you also want to transfer the music note to new location, You should use the 

“Change Staff” under “Western” menu.  The following is an example to change from 

G staff to C staff and all the notes also moved to new location:  

 

 
 

 



MusicWriter™ User’s Guide 

All Rights Reserved - 77 - Xiaoshu Xu 

 
  

 

2. Move staff up/down – a standard staff can be moved up or down.  Actually a C4 staff 

is just the C3 staff that moves up 2 steps.  Just select the staff cell and press icon 

.  Following is an example of a F staff moved down 2 steps： 

 

 
 

 

 

 
 

Note: All notes also moved down 2 steps up coordinately therefore it pitch is not 

changed. 

 

Note: You must only select one unit that the clef is on. 

 

     

3. Eight Step Staff – A staff can be 8 steps higher or lower than it was originally marked. 

Select the unit that the clef is at, then choose “8va Higher Staff” (or “8va Lower 

Staff”), see below example: 

 

 
 

4. Hide Part of Staff feature –“Staff Option”can be used to hide some staff feature. 

 

Hide Clef: 

 

 
 

Hide Key Signature: 
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Hide End Line: 

 

 
 

Show Start Line: 

 

Note: To conform to stand, starting from version 5.2, all start line are hidden. If you 

have needs, use this option to add it. 

 

5. Comment Staff – Sometimes composer need to add comments to explain how the 

note need to be played.  He can add a smaller staff on the top of the note to do so: 

 

First create a desired staff (C staff is good enough) on top of the note that will need 

to be commented: 

  

 
 

Then write the notes that to be commented: 

 

 
 

Finally choose “Hide Clef” and then select “Set As Comment Staff” 

 

 
 

10.4 Enter and Edit Music Notes 

 

There are several ways to enter the western notes. 
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Method 1 - Use the icons on the Western Notation float window.  To make the floating 

window appear, click  icon from Toolbar, or select Western Notation menu item from 

Windows menu.  See below: 

 

 
 

 

1. Select the cell or cells on the staff. 

 

2. Clicking on icon   will allow you add the proper rest notes.  

Just select the cell and click on the proper icon.  The rest notes will be place on the 

required location. 

 

 

3. Clicking on icon   will allow you to add the music 

notes with various time durations.  The note will be added to the default location (on 

the center line).  This is an example: 

 

 
 

The notes entered using this method will have the correct tail (time duration) but not on the 

correct position.  You need to click on the  icons or press UP or DOWN arrow keys 

to move it up or down.  There will be other method that we will discuss later to change 

their position.   Many of the buttons on the float window will have a key shortcut.  For 

example the 4th note button  has shortcut key “r”.  You can press key “r” to add the 4th 

note.  To see the shortcut key, simply move the mouse cursor to the button and you will 

see a popup hint window revealing the shortcut key.  If you can memorize the shortcut key, 

using the shortcut key can speed up your data entry a lot. 
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Method 2 - Use the Western Notation Letters.  Western music notes are denoted as C, D, 

E, F, G, A and B.  For example, to add a C note, you can press the key “C” or “c”.  The 

uppercase “C” will be 1 octave lower then lowercase “c”. You also can use “,” and “’” key 

to lower or raise the added note octave lower or higher like you do in simplified notation.  

For example, press key “,” first then press key “c” will make the added note 1 octave lower 

(equivalent to press key “C”).  You can even use multiple “,” or “’”. 

 

Method 3 - Use the Simplified Notation Numbers.  The simplified music notes are denoted 

as 1, 2, 3, 4, 5, 6, and 7.  It can be transfer into A, B, C, D, E and F based on the current 

clef.  For example, to add a note 4, you can press the key “4”.  If current clef is C clef, that 

will add a note F.  Just like in simplified music, you can use “’” or “,” key to make the note 

1 octave higher or lower.  For example, press key “,” first then press key 4 will make the 

note added 1 octave lower. You can even use multiple “,” or “’”. 

 

The “,” and “’” key can also use to modify the existing notes.  For example, press “,” key 

will make the selected notes 1 octave lower.  

 

The note create using method 2 or 3 will have correct position but they are all 4th notes.  

You can use the same method like in simplified notation to change it.  For example, type 

underline (_) will change 4th note to 8th note. Press dash (-) key will change 4th note to 2nd 

note, etc.  You also can use either the buttons on the floating window or the shortcuts that 

have been discussed in method 1 to change its tail (time duration).  For example, after 

select a note, press the icon  on the Western Notation floating window, or simply using 

the shortcut key “y”, the notes will change to 16th note (the position of the note will stay 

the same). You can also use the “Auto Underline” tool (see section 9.4) to add the tails 

automatically for you if you following the rules described in Section 9.4. 

 

Method 2 will make creating western note almost the same as in simplified notation system. 

10.5 Edit Music Notes 

 

Move Notes Position.  First select the note or notes to be moved.   

 

1. You can use the up and down arrow keys on keyboard to move them up and down.   

 

2. You can always use button  to move them higher or lower.    

 

3. To use western notation position, such as G and g, press key “G” or g.  If this is a 

chord, it will only move the root note to the specified location.  Other notes in the 

chord will adjust accordantly. 

 

4. To move to simplified notation position, such as 3, press key 3. The actually location 

will be determined based on current clef.  This method only works for single note, 

not chord. 
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5. To move the note 1 octave higher, press the key “’”.   Use key “,” to move it 1 octave 

lower. 

 

 

This is an example: 

 

 

Note：You cannot move the notes up/down that are on the percussion staff.  

 

There are other editing functions on the floating window. 

 

1. The  icon will flip the tail of the selected notes. 

 

2. Press  icon, or type “z”, will add additional notes to the existing note to create a 

chord.  A chord can have two or more notes.  

 

 
 

You can also use vertical icon in tool bar to create chord like in simplified notation.  To 

do so, just types the chord in continues cells, then selects all of them and click on the  

icon in toolbar.  See below: 

 

 

                            
 

3. To move a specific note in the chord up or down, first select the note, then press a 

number key 1 to 9.  1 means move the root (lowest) note, 2 means move the second note, 

and so on.  Then click on the  icons or press UP or DOWN arrow keys to move 

the specified note up or down.  When a number key is pressed on a chord note, a text 

will show up in the status bar at the bottom of the window to indicate which note will be 

edited (see below).  If no number key is pressed, the root note will be moved.  

 

 

 

 

 

 

 

After number 2 key is pressed, 

the status bar shows the change 

will apply to 2nd note 
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4. You can also use quick keys: hold ALT + UP or ALT + DOWN key to move the root 

(lowest) note.  Hold CTRL + UP or CTRL + DOWN key to move the second note, 

move the top (highest) note.  ALT+CTRL + UP or ALT+CTRL + DOWN key to 

move the third note.  ALT+SHIFT + UP or ALT+ SHIFT + DOWN key to move the 

forth note.  Finally the SHIFT + UP or SHIFT + DOWN key to move the topmost 

(highest) note.    

 

5. The  icon will delete an individual note from a chord. By default, the lowest (root) 

note will be deleted.  However, if you press number 1 – 9 before clicking on this icon, 

the corresponding note will be deleted.  For example, to delete the second note from 

the root note, press 2 first then click on this icon. 

 

6. Icon  will connect the tails of the selected notes.  For example: 

 

 
 

You can also connect the tails of notes that cross the G and F staff.  For example: 

      
 

To do so, the notes on the G staff need to have their stem downward and notes on the F 

staff need to have their stem upward.  The following are more examples: 

 



MusicWriter™ User’s Guide 

All Rights Reserved - 83 - Xiaoshu Xu 

 
 

7. Icon  will remove the connected tail: 

 

                                
 

8. If one notes is in G staff and one is F staff, they are on same column, has same tail 

and the tails are in same direction, the icon  can connects stems of two notes: 

: 

 

                                            
 

 

                                             
 

 

This is function like to move note from up staff into down staff. 

 

Note: The two staffs in Grand staff can have same clef, see below example: 
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Note: There is another way to move notes between two staffs. 

 

9. Icon  will move part of selected notes from G (or F) staff to F staff. 

 

                                         
 

 

By default, this function will move all notes below (include) center C (or above center 

C) to another side. However, you can use icon  beside the  to change the default 

value so more or less note will be moved.   
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For example, the original piece is:  

 

 
 

After apply this function: 

 

 
 

 

Using   can modify the default value to move more notes to F staff: 

 

 

Used for changing 

default value. 
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Note: Even though the method 8 and 9 can do exactly the same thing in appearance, 

they do have a difference:  In method 8 the notes always belong to the staff it located 

but in method 9 the moved notes will still belong to their original staff. Therefore the 

method 9 will be best to be used in G-F ground staff otherwise it can be very confused. 

 

 

10. Icons  will add appended dots for dotted notes. 

 

11.  Icon  will move the appended dot up or down one space: 

 

 

                               
 

If you want to move specific appended dot in a chord note, press the corresponding 

number key first: 

 

                               
                              

 

 

12. Icon  will increase or decrease the stem height: 
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13. When two alterations are too close together in a chord note, Icon can be used to 

move one of them left a little, click again will move even further: 

                                    

14. Icon  will add staccato dots to the selected notes.  Same as icons .  

Icon  can switch the symbol from head side to tail side: 

 

                                     
 

15. Icons  will add one, two or three short bars on the stem of the selected notes.  

See below: 

 

 
 

16. Icon  will remove the stem of the selected notes. 

 

17. Icon will break the tail connecting lines. For example: 

 

Used for changing  

stem height. 
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18. Icon  will remove the head of the selected notes 

 

17 and 18 can be used to create some special music notations.  These are some examples: 

 

. 

 

The first group of notes is a chord without stem. It is constructed by removing its stem.   

 

The second group of notes is created using the following method: 

 

• Create the half note and 4 16th notes normally: 

 

 
 

• Remove the head of the first 16th note: 

 

 
 

• Shift the half note position right (you may need to hold Shift key for fine adjustment).  

For better control, zoom in the view: 

 

符尾连线从此处

断开。 

符尾连线从此处

断开。 

符尾连线从此处

断开。 
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The third group of notes is created using the following method: 

 

• Create 5 16th notes normally: 

 

 
 

• Remove the head and stem of the last 16th note: 

 

 
 

The owner cell of any western music note is the cell on the staff although the note itself 

may be shifted up or down outside the staff.  Therefore to select the music note, you must 

select the cell on the staff line, which is not necessarily the cell that the note appears to be.  

See the following example: 

 

 

 

 

 

 

 
 

 

Use these function you can create very complicated music pieces, for example the 

following is piece of Beethoven Symphony No 3: 

 

 

The owner cell 

of the note 
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10.6 Symbols and Dynamitic Marks 

 

Many symbols and dynamic marks used in Simplified notation can also be used in 

Western notation.  For example, you can add sharp, flat or nature sign to the notes just 

like in the simplified notes.  You can also add slur to connect two or more notes, or add 

piano paddle marks. Please refer to the sections in chapter 3 for details.  The following is 

an example: 
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10.7 Slur Marks 

 

Even though most of dynamitic symbols in western notation are the same as in Simplified 

notation, the slur is an exception.  Unlike the slur in Simplified notation, which is always 

laying horizontally, the slur in western note is tied along the notes.  See this example: 

 

 
 

Normally, you add slur in western notation just like you do in simplified notation, that is 

select group of notes that you like to connect with slur, then press “ ” button in the 

Dynamic Mark window.   However, there are some special cases we need to point out:  

 

1． Please note that the owner cells are always on the staff lines though the notes 

themselves may shifted outside the staff.  See following example: 

                                     
 

If needed, you can use the dynamic edit buttons to adjust the shape of the slur. 

 

2． Use  to switch the direction of the slur. 
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3． Sometimes in grand staff the slur can cross G and F staff.  You can use the 

dynamic edit buttons to make this happen: 

 

a. First setup a slur on the G or F staff, make sure the slur has enough length to cover 

the entire notes (on both G and F staff) that you like to be connected. 

 

 
 

b. Using  and  to move the tail end of the slur to the desired position. 

 

 
 

c. The using to change the slur curve to a desired shape. 

 

 

 
 

Again  is an ellipcal1 slur while  is a arc slur, see section 3.4. 

 

4． Slurs on the tie chords 

 

System will automatically add multiple slurs for tie chords: 
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If you use icon to change thedirection of the slur, by default it will change the 

bottom(root note) slur.  If you want to chage other slurs on the notes, you need first type a 

related number key then click on icon . The following example we type number “2” 

key first, then it will change the second slur direction. 

 

 

                                
 

 

5． Create multiple slurs 

 

Many times multiple slurs on a single note are needed. To do so, following these steps: 

 

a. Create a single slur as you normally do： 

 

 
 

b. Using an empty cell above the staff to create a independent slur with desired 

length: 

 

 
 

 

 

c. Then using ， ， to adjust it to the desired location and shape 

Similar techniques can be used if more than 2 slurs are used. 
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11. Converting Between Simplified and Western Notation 

11.1 Convert from Simplified to Western 

 

You can convert music from Simplified notation to western notation: 

 

1. Select Simplified to Western menu item from Western menu.  You can choose either 

convert only the selected area, or from the current selected position to the end. 

 

2. If no key signature is found, a dialog box will pop up to allow you to choose the 

proper staff for the western notation.   

 

 
 

3. There are two types of key in simplified notation: Movable Do and Fixed Do.  See 

11.4 for details. 

 

The following is an example. 

 

Music in simplified notation: 
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The same music piece after it converted to Western notation: 

 

 
 

Because the western notation has clef and key signature on the front of the staff, the 

Simplified music needs to have at least 4 empty cells at the beginning of each music line to 

give enough room for the clef and key signature after it converts to western notation.  If a 

line of music does not have enough empty space on the beginning, a message window will 

pop up to warn that some data maybe lost due to lack of space. 

 

The shrink and decoration notes will also be converted correctly as shrink and decoration 

notes.  The vertical (core) notes also will be converted correctly. 

 

If there are errors during conversion, the cells that contain the errors will be highlighted 

after the conversion.  If there are simplified notes left, that also indicates possible errors.  
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However sometimes the error may not be detected by the software and therefore will not 

always be highlighted.  You need to always examine the result carefully after conversion 

and manually fix any errors. 

 

You can also convert full score music.  See the following example: 

 

The music in Simplified notation: 

 

 
 

The same music converted to Western notation: 
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In the above example, you can see that even percussion instruments have been converted 

accordantly.  You can also see the place where been highlighted.  These are place that may 

have not correctly converted and you may need pay attention for it.  You may also edit the 

music to make it looks better.   

 

There are several notes regarding this conversion: 

 

1. The individual dot has to be in the same layer as the associated note. 

 

2. The dash has to be in the same layer as the associated note. 

11.2 Change Western Staff 

 

In some case, the staff used by the conversion may not be what you want, for example the 

Base staff may create with G staff instead of F staff.  You can easily change the staff using 

the menu item Change Staff from Western menu. 

 

1.  Select the row that its staff needs to change. 

 

2.  Choose menu item Change Staff from Western menu, there will be 4 submenu items can 

be used. Using them you can change the currently selected staff to G, F, C, or percussion 

staff.  All notes in the staff will be also adapted to the new staff. 
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The following is the result of converting G staff to F staff：  

 

 

11.3 Convert from Western to Simplified 

 

You can convert from Western notation back to Simplified notation by using the Western 

to Simplified menu item from the Western menu.  The following is an example of 

converting the same piece above back to Simplified.  If any possible error is detected 

during the conversion, the corresponding cells will be highlighted.  Also if you see any 

western notes left, that will indicate a possible error area.  Again, you must manually fix 

these errors. 

 

There are several notes regarding this conversion: 

 

1. In western, many times it can add two part of the music in the same staff, for 

example: 

 

 
 

Normally the second part of the music is added in the back layer (see section 13 for 

back layer). 

 

Since Jianpu has no easily way to add two lines of music in a single line, we will 

convert the second music part (shown in back layer) at top of current line in back 

layer as well.  The software will still recognize it as part of the music and all 

functions such as playing music etc., will work just fine.  This is the piece above 

converted to Jianpu: 
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2. For full and half notes, in west staff they only occupy a single cell but in Jianpu it 

will show as a 4th note with added dash.  When convert these notes, the software 

will try to find empty space after current note to add needed dash.  However, if 

there is no enough space, it will stop try and highlight these cells to warning you to 

recheck them.  See following example: 

 

 

This is an example that has no enough space to convert a half note: 

 
 

 

 
 

3. Double alteration:  in west notation sometimes double alteration, such as double 

sharp or double flat.  But in Jianpu we normally do not use double alteration.  

Therefore software will highlight these cells to warning you. 
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11.4 Movable Do and Fixed Do Key 

 

In simplified music notation, there are two types of key: 

 

Movable Do (also called Tonic So-Fa) Key: The key is defined by key signature, such as 

“1=G”, in such case the 1 is G, and 2 is A, etc. 

 

Fixed Do Key: The key is always in C, that means 1 is always C, 2 is always D, etc. 

 

These are same piece of music converting in Movable Do key and in Fixed Do key: 

 

Original staff piece: 
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Movable Do key style: 
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Fixed Key Style: 
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12. Transpose Staff Key 
 

Many functions under “Western” menu are explained above. Here we explain rest of the 

functions: 

 

12.1 Transpose Staff Key 

 

This function will transpose from one key to another.  For example, following is a piece 

written in key C: 

 

 
 

 

Now we can transpose them to any other tones. Select “Transpose Staff Key”, a popup 

window will be shown: 
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Choose proper key you want to transpose, in this sample choosing one step up to key D.  

We get: 

 

 
 

Note:  In this function program always treat it is a Major music. 

 

12.2 Note Hints 

 

This is the “Show Hint” submenu under “Western” menu: 
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These functions  can be used to show the hint for the notes to assist  you quickly read the 

music.  The hint is in letter （C,D,E,F,G,A,B）or in number (1, 2, 3, 4, 5, 6, 7).  Use 

“Show Hint in Jianpu” sub menu item to switch between them. 

 

There are two styles of hint.   

 

1. Once “Enable Popup Hint” is checked, a yellow hint box will show when you select a 

cell that contains a music note: 

 

 
 

If you choose to display the hint in Jianpu, it will be shown as: 
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Jianpu hint can be displayed in Fixed Do key or Movable Do (Tonic So-Fa) key, see 

section 11.4 for details. 

 

2. You can also add all hints to the selected area or even entire music.  In such case the 

hint will added on top of the note(s): 

 

 
Or it is shown in Jianpu format: 

 
You also can use “Hint Text Size” to change the text size of the hint. 

 

There are other functions in this submenu to help you quickly read the music: 

 

 

1.  Color Staff  Lines: 
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2.  Show all black key note in different color.  The red color means rise half step and 

green color means lower half step: 

 
You can change the default color in Preference window. 

 

Using all needed functions, you can create complicated staffs.  The following is a example 

from Beethoven Piano Concerto No.3:  

 



MusicWriter™ User’s Guide 

All Rights Reserved - 108 - Xiaoshu Xu 

 



MusicWriter™ User’s Guide 

All Rights Reserved - 109 - Xiaoshu Xu 

13. Create Music Book 
 

Music Book allows you to organize the music by books.  Clicking on the icon  from 

toolbar or choosing Book from the Tool menu will pop up the Music Book dialog: 

 

 
 

13.1 Add and Remove Music in the Book 

 

To add music to the book, click on the  icon, a file selection window will pop up 

allowing you to select one or more music files (MUS files) to add.  The music will always 

add at the bottom of the music list.  You can change the order using the up and down arrow 

icons, see next section.  

 

After music is added, the dialog will look like: 
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All the music contained in the book will be listed in the table.  The table lists the title of the 

music, file location, start page of the music in the book and number of pages of the music. 

13.2 Edit the Book 

 

In Music Book dialog, there are several ways to edit the book contents. 

 

1.  Delete Music – You can delete any music by selecting that row and click on the  

icon or simply press the DEL key 

. 

2.  Change the Order of the Music List – you can change the order of the music.  Select 

the row then click on the  or   icons will allow you move that row up or down. 

 

3.  Change Music Title – We have discussed how to decide default music title for the 

music in section 7.3.  You can change the default title to any other text by either 

double clicking on the music title or selecting the music and click on the  icon.  A 

text edit dialog will pop up to allow you enter English or Chinese. 

 

4.  Change Music Location – The music location can also be changed.  Simply double 

click on the music location or click on the  icon, a file selection dialog will pop 

up to allow you to specify the new location for this music. 

 

5.  Add Book Title – The book title can be used to identify this book.  It also can be seen 

in the footnote of the print copies. Pressing the Edit button will allow you to enter the 

book title in either English or Chinese. 
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6.  Add Title Page – Title page is no more than a single page music file.  It can contain 

any object, such as music title, publication information or images. The title page, if 

included, will be the first page of the printed copy.  

 

7.  Open the Music – You can open the selected music by clicking on the  icon or 

double clicking on the “Start At” column. 

13.3 Save, Open and Create New Book 

Click on the icon on the Music Book dialog will create a new book.  After a book has 

been created, you can save the book and load it back later.  To save it, click on the  

icon for Save or  for Save As.  A saved file dialog will pop up allowing you to enter a 

file name.  The music book file always has extension “mbk”. 

 

To load a pre-saved book, click on the  icon, then select the book file to open.  

Clicking on the down arrow will allow you select up to 5 recent books from the pull down 

list.   

 

The book file will only save the pointers to the location of each music file it contains, not 

the music file itself.  So if the specified music file does not exist, it will display the text of 

that file location of the music in red.  If you do not manually relocate the file, it will be 

ignored when you print the book. 

13.4 Print Book 

 

Clicking on the  icon will pop up the Print Book Wizard that allows you to print the 

book. 
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On the first page of the wizard, you can select various options, such as one side or two side 

print.  If it is one side print, you can also choose to print front, back, or both side.  This will 

allow you to emulate the two side print by print the front page first, then flip the papers in 

the printer and print the back pages on the pack of the paper. 

 

If you choose to include a table of contents, the table of contents will be automatically 

generated and printed after the title page (if title page is included). 

 

You can also choose to include the title on the footer of the page and file name on the top 

of the page. 
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On the second page, you can specify which pages to be printed and then press Print to 

execute. 
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14. Main Layer and Back Layer 

14.1 What is the Layer 

 

The MusicWriter actually have two layers, the main layer and the back layer.  The main 

layer is the default layer and in most of time, you can do all things you needed in main 

layer.  But occasionally, you may not have enough spaces in main layer.  Switch to back 

layer will give you great flexibility to do what you want. 

 

You can think that the back layer is another entire page that is transparently overlaying on 

top of current page.  All the notes, symbols, and others on the back layer will be 

overlapped with the main layer and will be printed just like the ones that are on the main 

layer.   However, you can only edit one layer, called active layer, at a time.  The staff on 

the inactive layer will be displayed in gray, while the staff in active layer will be displayed 

in black (if the main layer is active) or dark green (if the back layer is active). 

 

 

 

 

 

 

 

 

 

Even though the notes on different layer are displayed in different color, when the music is 

printed or copied to the clipboard, they all use the black color. 

14.2 Use Back Layer 

 

To switch between back layer and main layer, click on the icon on tool bar, or choose 

menu item “Switch Layer” under View menu.  The number 1 in the icon means you are on 

main layer and number 2 means you are on back layer.  This is the same example above 

but viewing in back layer: 

 

Notes in 

inactive layer 

(back layer) 

Notes in 

active layer 

(main layer) 
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You edit the back layer just like you do on the main layer.  However, you should only use 

the back layer as a supplementary data area.  One very good example is to use back layer 

to create multiple parts of the music on western notation that shares the same staff, as the 

example we see above.  

 

Note: Staff, time signature, Key signature, and tempo sign cannot add to back layer.  

They must be shown on main layer. 

 

Under View menu there are two other items related to layer: 

 

⚫ Switch Layer Content: switch layer contents of the selected unit.  

 

⚫ Move to Next Layer: move current notes in selected unit to other layer. 

 

14.3 Create Two Parts Music in One Line 

 

At section 6.5, we talked about create two part music in one line that do not have the same 

lasting time. For example: 

 

 
 

 

First we create the first part music in main layer, then change it to vertical note (even it has 

only one note, you still can change it to vertical).  Move to up to a proper position,| then go 

to back layer create second part music, again change it to vertical note and move it down to 

proper position.  See below: 
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15. Play Music 

15.1 Play Music Window 

 

You can play the music using “Play Music” floating window.  The window looks like: 

 

 
 

Play Button – Click on this button will start play currently open music, starting from 

current selected cell. 

 

List button – Play a selected list of music pieces. 

Stop button – Stop play when clicked 

 

Speed Adjust – It adjust the play speed.  For example, 50% will slow down the play speed 

by half.  The method to determine the play speed is explained in section 14.2 

 

Ignore Tempo Signs – When this checkbox is checked, the tempo signs (see 14.2 for 

tempo signs used in the play) on the music will be ignored and the music will be played 

with a constant speed （100 beats per minute）. 

 

Ignore Dynamic Signs – When this checkbox is checked, the dynamic signs (see 14.3 for 

dynamic signs used in the play) on the music will be ignored and the music will be played 

with a constant volume 

 

Music can be played with different music instruments. You can click on icon  to put 

current music instrument on the different location of the music, by this way you can play 
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the music with different instruments on different parts.  In example below, the music will 

be played with piano and violin at different parts: 

 

 
 

15.2 Tempo Signs Used in Playing 

 

Tempo signs are used to mark the playing speed.  The playing recognizes many of the 

tempo signs marked on the music.  The tempo signs can be put at beginning of the piece 

and middle of the piece as well.  If it is put at beginning of the piece, it can be at any places 

before the first note. If it is put at middle of the music to indicate the change of the tempo, 

it can be put at the above or below the note where the tempo starts to change.  In the 

following example, you can see two tempo signs, “慢板” is at beginning of the piece and 

“rit.” is close the end of the piece and is located at below the note “7”. 
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The following table lists all tempo signs that will be recognized by the playing. If the 

music has no speed sign, it will be played at 100 beats per min. 

 

Tempo Sign Remark 

 
Play at give speed.  Must use button  in tool bar to add Speed 

sign. 

Largo 

极慢板 

极慢速 

Play at 55/min 

Larghetto, 

慢板 

慢速 

Play at 65/min 

Adagio Play at 75/min 

Andante 

中 板 

中速" 

Play at 85/min 

Moderato 

小快板 

中快速 

Play at 100/min 

Allegro 

快 板, 

Play at 120/min 
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快 速 

Presto 

急板 

Play at 160/min 

Prestissim 

特快板 

Play at 200/min 

稍慢 Play slower (1/5 slower) than current tempo 

稍快 Play faster (1/5 faster) than current tempo 

rit, 

rita, 

渐慢 

These text symbols will slow down the tempo gradually.  The 

slow down process will continue until to the next tempo sign, or 

to the end of piece. 

a tempo, 原速 These text symbols will restore the tempo. 

 

15.3 Dynamic Signs Used in Playing 

 

The playing recognizes many of the dynamic signed marked on the music.  MusicWriter 

gives maximum freedom to the uses to create the music.  This freedom allows user to put 

these signs to any places he wanted that creates uncertainty to the format.  Therefore for 

the playing to correctly interpolate the dynamic signs, we need restrict the dynamic 

symbols only to be located BELOW the targeted notes.  The following list gives all 

dynamic signs that will be recognized by the playing and rules they need to follow. 

 

Dynamic Symbol Remark 

ppp 

最弱 

play at 15% of the full volume 

pp 

弱 

play at 25% of the full volume 

p 

中弱 

play at 35% of the full volume 

mp 

稍弱 

play at 45% of the full volume 

mf 

稍强 

play at 55% of the full volume 

f 

中强 

play at 70% of the full volume 

ff 

强 

play at 85% of the full volume 

fff 

最强 

play at 100% of the full volume 

sf, sz suddenly louder, double current play volume 

fp, sfp 

突强 

suddenly louder, double current play volume, then 

back to normal volume. 
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cresc. 

渐强 

crescendo,  increase play volume gradually. 

 
dim. 
dimin. 

渐弱 

diminish,  decrease play volume gradually. 

 

 

 

The following is an example: 
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15.4 Advanced Play Choice 

 

Advanced play tab is shown below: 

 

 
 

Even though the play functions can automatically recognize many dynamic marks and play 

accordingly.  However you still can use these functions on this tab to modify the default 

play behavior.  For example you can make the crescendo more aggressive or vise vase. 

You also can change the default play volume or speed of rallent or arpeggio.  

 

Here the “Change Play Duration” is a function we need to explain in more detail.  See the 

following piece: 

 

 
 

The software will play each note in dash box as quart notes since it has no way to know 

how to play them otherwise.  However, as a human player, one knows when one note is 

played 8th notes long the next note need start to play.  To make the play correct, you can 

manually change the duration of these note to 8th note though it still last as quart note but 

the following note will be start in correct time.  
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15.4 Other Recognized Signs  

 

Turn Sign: The turn signs can be put at beginning of the piece and middle of the piece as 

well.  If it is put at beginning of the piece, it can be at any places before the first note. If it 

is put at middle of the music to indicate the change of the turn, it must be put above the 

note where the turn starts to change. In the following example, music start with turn F, then 

it changes to Turn G. 

 
 

Shrink and Vertical Notes： Playing will honor the shrink and vertical notes. The 

vertical notes will be played as a chord.  For example: 

 

 
 

Other Symbols: Besides all symbols mentioned above, the playing also recognize some 

other signs.  They are: 
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Signs Remark Example 

tr,  
Add above targeted note 

,   

Decorate notes Add before and after the 

targeted notes.  

> 
Add above targeted note. 

Play loud for this note 
 

. 

Add above targeted note. 

Play shot for this note 
 

 

Triplet or multi-let notes.  It 

has to be add using the 

button  in dynamic float 

window in order for playing 

correct. Will work in 3.81 

 

 
 play twice longer. 

 

#, b,  Add at front of target note 
 

 

Play as a serious notes 

separately 

 

 

Repeat sign, notes between 

repeat sign will be played 

twice.  
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16. Virtual Keyboard 

By click on icon  on toolbar or choose “Virtual Keyboard” under tool menu can bring a 

virtual keyboard at lower part of the window. See below:  

 

 

 
 

When virtual keyboard is shown, you can perform following functions: 

 

⚫ When you play a music, the related keys on the keyboard will be pressed (shown in 

different color.) : 

 

 
 

⚫ If you us mouse to click on one of the key，the related sound will be played. The 

sound will stop when you release the mouse.  If you want the sound continue (like 

the paddle is pressed), hold Alt key.  If you like to play multiple keys at once, hold 

Ctrl key and click on keys on the keyboard, see below: 
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⚫ If “Keyboard to Note” is checked, the related note will be write to the current 

location when you click on the keyboard (assume it is valid): 

 

 
 

 
 

If you want to write a chord, hold Ctrl-Key: 

 

 
 

 

⚫ If “Note to Keyboard” is checked, the related key(s) will be pressed when mouse is 

click on a note(s) on the music piece: 
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17. GongChi (工尺) Music 

 

GongChi music is a tradition music noting system that has been used for more the 1000 

years.  Though today it has not as popular as other notation systems but it still used in 

some Chinese operas.  And also this is a part of cultural for Chinese music and many old 

music pieces are still written in GongChi.  The purpose to have ability to write GongChi in 

this program is to try to make contribution to preserve this age-old culture. 

 

Simply click on menu item “GongChi” in “Window” menu at top tool menu or click on 

icon  on tool bar, the system will turn into so called “GongChi” mode.  Since GongChi 

uses modified Chinese characters to record the notes, the cells will change to square.  Each 

square can host one GongChi characters.  All GongChi characters will show on a float 

window.  See below: 

 

 
 

In GongChi mode, you click on any button on the GongChi window will add 

corresponding characters to the selected cell.  You can also use number key 1-7, they are 

corresponding to characters “上尺工凡六五乙”. Using “,” key you can add one or two dot 

on the right-bottom of the characters to lower them by 1 or 2 octaves.  Same reason, you 

can use “’” key to raise them 1 or 2 octaves. The “,” and “’” keys can be applied before or 

after the number key pressed.  This rule is just as the same as in the simplified notation.  

Other functions are same, such as move, copy, delete etc. 

 

When you close the GongChi window, system is back to normal mode.  All other functions 

are still works with GongChi notes.  You can also mix GongChi notes with Simplified 

notes, even mix with western notes. 

 


